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Welcome to ProSeries® Express Edition tax software

ProSeries Express Edition tax preparation software is designed for tax professionals who 
file 50 or more bank product tax returns each season. ProSeries Express Edition offers:

● A fast, innovative new approach to preparing income tax returns for clients 
requesting bank products

● Several bank product disbursement options including RT Checks, RTDDs, State RTs, 
Cash Cards, RALs, RAL/RT Advances, and Pre-season RAL/RT Advances

● Unlimited e-filing for 1040 federal returns and three individual state returns; or 
unlimited e-filing for 1040 federal returns and all state returns depending on which 
version you’ve purchased.

ProSeries Express Edition saves you time by allowing you to:

● Check electronic filing and bank products acknowledgements in a single step

● Use a refund monitor that tracks federal and state calculations in real time

● Use ZIP Code and Employer/Payer EIN databases to speed data entry of your clients’ 
information

● Offer the ProSeries Express Refund Infoline (at no cost to ProSeries Express Edition 
customers in Tax Year 2005), a toll-free telephone number that your clients can call 
to check their tax refund or bank product status 24 hours a day, seven days a week

● View a client snapshot screen, color-coded data entry fields, a client questionnaire 
form in both English and Spanish, and more.
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Computer system requirements for stand-alone 
computers

Make sure that each computer on which you intend to use ProSeries Express Edition 
software meets or exceeds the minimum requirements for all relevant components.

The minimum requirements shown below should provide adequate performance on most 
computer configurations. The software may not operate as designed on systems that 
don’t meet the minimum requirements. For more information about how system 
requirements can affect the operation of ProSeries Express Edition software, go to 
http://www.proseries.com.

Important. Using ProSeries Express Edition on a Windows 98 operating system on a 
server or serving computer is not supported in Tax Year 2005

Component Recommended Requirement Minimum Requirement

Computer Pentium 4, 1.3 GHz or faster Pentium 266 MHz or equivalent AMD 
processor

Memory 512 MB RAM or more. More memory 
normally results in improved 
performance.

128 MB RAM. More memory may be 
required if you install many products 
and have a large number of clients.

Hard disk space 2 GB or more, depending on the 
number of products you install and the 
number of clients you have.

650 MB. More space may be required if 
you install many products and have a 
large number of clients.

Windows 
operating 
system

One of the following:

Windows 2000 (service pack 3 or later)

Windows XP (Home or Professional 
edition)

One of the following:

Windows NT (version 4.0, service pack 
6a or later)

Windows 98 (second edition)

Windows ME

Screen 
resolution

1024 x 768 or higher 800 x 600

Printer Hewlett-Packard LaserJet Series 4 or 
later (or 100% compatible) with at least 
1 MB of printer memory

Hewlett-Packard LaserJet or PCL 
compatible with 1 MB of printer 
memory

Disk drive CD-ROM 12X or faster CD-ROM 6X or faster

Internet 
connection

High-speed Internet connection (such 
as T-1, DSL, or cable modem) or 56 K 
modem

28.8 K modem

Internet 
Browser

Microsoft Internet Explorer 6.0 or later Microsoft Internet Explorer 5.5, service 
pack 2 or later. (Internet Explorer 6.0 is 
installed if Internet Explorer 5.5, 
service pack 2 or later isn’t already 
installed.)

Internet Service 
Provider (ISP)

ProSeries Express Edition software 
works with most ISPs. Contact your ISP 
if you have a specific question.

An ISP is required for features that use 
the Internet, such as online delivery of 
products and electronic filing.
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Getting ready for the 2005 tax season

Know your responsibilities. You and your clients are responsible for correctly reporting 
all information that is required by the Internal Revenue Service or applicable state taxing 
agency, and for the accuracy of each return that you file.

Be familiar with your computer system. If you’re unfamiliar with the basic operation of 
your computer, your Microsoft Windows operating system, or your computer network (if 
applicable), read the owner’s guide for your computer, Windows help, or the network 
documentation.

Understand the ProSeries Express Edition License Agreement. You must read and 
understand the ProSeries Express Edition Software License and Services Agreement 
(“License Agreement”). The ProSeries Express Edition License Agreement opens at the 
start of the installation procedure. After the software has been installed, you can review 
the ProSeries Express Edition License Agreement in the Help Center or the ProSeries 
Express Edition User’s Guide. Please note the following conditions of the ProSeries 
Express Edition License Agreement:

● You are licensing the software for use by a named entity and its employees at one 
identified location.

● You are representing to Intuit® that the firm name and address you provide is the 
primary firm name and location used in the normal course of business.

• This is the name and address under which you market yourself and your 
professional services.

• This firm name and address will appear in the “Paid Preparer” designation on tax 
returns.

● You may enter information about as many preparers as needed, provided that they 
all are employees of the firm listed at that particular address.

● Multiple preparers who operate as separate and distinct firms—even if they share 
office space—are considered to be unique and each preparer must purchase a license 
for his or her own copy of ProSeries software.

Preparing for electronic filing

If you want to file returns (or extension request forms) electronically, you must be able to 
connect to the Internet from the computer on which you install the ProSeries Express 
Edition program. In addition, you must have an IRS-issued Electronic Filing 
Identification Number (EFIN).

If you are new to electronic filing or no longer have a valid EFIN, you can apply for one 
using either of the following methods:

● Online. To use the IRS e-file application, go to http://www.irs.gov, select the e-file 
link, then click on the e-services link in the e-file for Tax Professionals section.

● Form 8633. Submit Form 8633, Application to Participate in the IRS e-file Program.

Important: You must use the version of Form 8633 dated July 2003. If you submit 
an earlier version, the IRS will reject your application. The IRS recommends that you 
submit your application at least 45 days prior to the date that you intend to begin 
filing returns electronically. You can find Form 8633 and information about 
electronic filing at the IRS Web site, which is http://www.irs.gov/.

Tip: The IRS strongly recommends that you use the online method to apply for an EFIN.
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You can find information about electronic filing at http://www.proseries.com. Select 
Products, then Electronic Filing. If you have additional questions about electronic filing, 
call the IRS e-help desk at 1-866-255-0654.

State enrollment requirements

Some states require additional electronic filing enrollment paperwork. Verify the 
electronic filing enrollment requirements for each state where you plan to file returns 
electronically. You can link to each state taxing agency’s Web site from 
http://www.proseries.com. Select Tools, then Tax Links, then State Tax Departments, 
then the name of the state.

Preparing to offer bank products

When you file your clients’ individual returns electronically, they can receive 
disbursements based on their expected federal refunds in the form of:

● Refund Anticipation Loans (RALs)

● Refund Transfers (RTs)

● Refund Transfer Direct Deposits (RTDDs)

● RAL/RT Advances up to $1000

● Pre-season RAL/RT Advances that you can offer to clients who have a W-2 in hand 
starting January 3, 2006

Important: If you are going to offer Pre-season RAL/RT Advances, you must advise your 
clients that their tax returns will not be sent to the IRS until the Intuit Electronic Filing 
Center opens for e-filing in mid-January 2006.

Your clients can also receive disbursements based on their expected state refunds in the 
form of Refund Transfers (RTs). In addition, your fees are deducted from the client’s 
refund and deposited into your bank account electronically.

Before you can offer bank products to your clients, you must first apply to Santa Barbara 
Bank & Trust, Republic Bank, or First Security Bank to participate in their banking 
products program. Go to the Bank Products section of ProSeries.com to learn how to 
register.

Tip. The first time you start the ProSeries Express Edition program, you see an Enroll with 

SBBT dialog box that includes a link to the applicable page at ProSeries.com. 

For more information about bank products, see “Offering Bank Products to your clients” 
on page 44.

How to accept major credit cards and eChecks

You can use the ProSeries/Merchant Account Service to accept payment for your services 
by major credit cards and eChecks. If you aren’t already a ProSeries/Merchant Account 
Service customer, you must apply for the ProSeries/Merchant Account Service program. 
To apply, go to http://www.proseries.com, select Products, select Services, then select 
ProSeries/Merchant Account Services.

Tip: To apply for the ProSeries/Merchant Account Service program within the ProSeries 
Express Edition program, go to the Tools menu, select Accept Credit Cards/eChecks, then 
select Sign Up.
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Ordering presentation folders and envelopes

To purchase presentation folders and window envelopes, call Professional Tax Products at 
1-888-236-8137, or go to the ProSeries Web site at http://www.proseriessupplies.com.

Using ProSeries Express Edition on an unlimited basis vs. a 

pay-per-return basis

You can use each ProSeries Express Edition tax product and electronic filing product on 
an unlimited basis. However, you can also use the program on a pay-per-return basis. 
Here are the differences:

Unlimited basis. When you use a tax product or electronic filing product on an 
unlimited basis, you pay a fixed fee to purchase that product, but you don’t pay a fee to 
print or convert returns for electronic filing (tax product), or to file returns electronically 
(electronic filing product).

Pay-Per-Return basis. When you use a tax product or electronic filing product on a 
pay-per-return basis, you don’t pay a fee to purchase that product, but you must 
authorize payment for each return before you can print it or convert it for electronic 
filing (tax product), or before you can file it electronically (electronic filing product).

Important: Service and delivery fees are separate from product purchase fees.

ProSeries Express Edition software enables you to prepare the following types of returns 
on an Unlimited basis: 1040, 1120, 1120S, 1065, 1041, and 990 federal returns, 
individual state returns for the states that you select, and business state returns for the 
states that you select.

If you want to prepare 706 or 709 federal returns, you can prepare these returns on a Pay-

Per-Return basis.

New for Tax Year 2005. You can choose a “bundle” of tax products that are 
appropriate for your tax practice when you purchase ProSeries Express Edition. For Tax 
Year 2005, a three-state return bundle and an unlimited state bundle are offered along 
with unlimited federal returns and Pay-Per-Return tax returns.

Important: To order the Unlimited version of a ProSeries Express product, call ProSeries 
Express Sales at 1-877-866-5232 or order online at http://www.proseries.com. The product 
information in your customer record will be updated. Product licensing can be done 
automatically if your computer is connected to the Internet (which is the recommended 
method), or you can use the manual method for product licensing.

When you install ProSeries Express Edition software, you’ll select the tax products that 
you want to install. If you haven’t already purchased the Unlimited version of a tax 
product or corresponding electronic filing product, the Pay-Per-Return version of that 
product will be installed.

You will be prompted for information about the following topics while you’re setting up 
ProSeries Express Edition. (You can enter this information later as you use ProSeries 
Express, if you prefer.)

For this topic You should know this

Product Licensing The Customer Number and ZIP Code are printed in the Sold To: area of the 
packing slip (which accompanied the ProSeries Express Edition CD).

Firm and Preparers Basic information about your firm and the preparers who will be using the 
ProSeries Express Edition software.
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Getting your computer system ready

You can install ProSeries Express Edition software for stand-alone use or for network use. 
First, decide how you will install and use ProSeries Express software, then get your 
computer(s) ready.

Important: Before you can install ProSeries Express Edition software for network use, we 
strongly recommend that you purchase the ProSeries Express/Network Version product.

Decide how you are going to use ProSeries Express Edition 

software

How you install and then use ProSeries Express software depends on several factors, 
including the number of computers on which you want to use ProSeries Express.

One computer. If you’re going to use ProSeries Express software on one computer, install 
the program for stand-alone use on that computer’s hard drive. See “Installing ProSeries 
Express Edition 2005 software” on page 8.

Multiple computers. If you’re going to use ProSeries Express Edition software on more 
than one computer, you can install the program for stand-alone or network use.

● Stand-alone use. If each preparer maintains an independent set of clients, install the 
program for stand-alone use on each computer.

See “Installing ProSeries Express Edition 2005 software” on page 8 for instructions.

Important: If your firm will be filing returns electronically from more than one 
computer using the same EFIN on each one (and the program is installed for 
stand-alone use on each computer), be sure to see “Setting up the DCN counter on 
multiple stand-alone computers” on page 34.

● Network use. If preparers regularly share tasks and review returns for other preparers, 
install the program for network use.

ProSeries Express Admin workstation. Install the ProSeries Express shared 
network components to a shared drive from the computer you choose to be the 
ProSeries Express Admin workstation. You’ll also install and set up the program 
on the ProSeries Express Admin workstation at that time.

Any computer (including the network administrator’s workstation) can be the 
ProSeries Express Admin workstation. However, we strongly recommend that the 
ProSeries Express Admin workstation have an Internet connection to help ensure 
that you always have the latest version of your ProSeries Express tax products.

Electronic Filing Information about the person who will be the electronic filing contact for 
your firm, if you’re going to offer electronic filing to your clients

Bank Products Your bank products registration information, including information about 
the bank account where your fees will be deposited

Billing How you want to set up ProSeries Express billing options such as standard 
fees, hourly charges, and per-form charges

Service Bureau Enter a Master EFIN, an Intermediate Service Provider number (SBIN), or 
both. Enter a Service Bureau Fee and choose which EFINs that you want to 
include in your Service Bureau.

For this topic You should know this
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ProSeries Express User workstations. Install and set up the ProSeries Express 
program on each additional computer that will run the program (and that will 
access ProSeries Express shared network components and client files from the 
shared drive where ProSeries Express is installed).

For instructions, see the ProSeries Express Edition Network Installation Guide that 
you received if you purchased ProSeries Express Edition/Network Version.

Important: If a preparer is going to prepare returns on a laptop or notebook computer 
that will be mobile (in a manner permitted by the ProSeries Express Software License 
Agreement), install ProSeries Express for stand-alone use on the hard drive of that laptop 
or notebook computer.

Important: Make sure to use the Copy/Backup and Restore commands on the Client 

File Maintenance menu (which is accessed from the File menu) when “moving” client 
files from the network to the laptop or notebook, or from the laptop or notebook to the 
network.

Prepare your computer system

We suggest you review the following before installing ProSeries Express Edition software.

Internet connectivity

Having an Internet connection allows you to take advantage of ProSeries Express Edition 
features such as online delivery of tax products and tax product updates, product 
licensing, electronic filing, bank products, and the ProSeries.com Web site.

We recommend that the following computers or workstations have a valid Internet 
connection before you install the ProSeries Express Edition software:

● Each computer on which you will install ProSeries Express software for stand-alone 
use

● The ProSeries Express Admin workstation from which you install ProSeries Express 
software for network use, because all product downloads and product updates must 
be done at the ProSeries Express Admin computer

Computer performance

We strongly recommend that you do the following for each computer that will run 
ProSeries Express software:

● Run the Scan Disk and Disk Defragmenter system tools to correct any errors on the 
hard drive and speed up access to the contents of the hard drive. (For more 
information, refer to Windows Help.)

● Use virus-protection software to check for viruses on the hard drive.

Know the location of your ProSeries Express Edition 2004 client files

ProSeries Express Edition software for the 2005 tax year can transfer relevant data from 
ProSeries Express Edition 2004 client files (or data converted to 2004 ProSeries Express 
data) into new ProSeries Express 2005 client files. You can also transfer relevant data from 
ProSeries Professional 2004 client files and ProSeries Basic 2004 client files.

If you used ProSeries Express software for the 2004 tax year, make sure you know the 
location of last year’s ProSeries Express client files—especially if your ProSeries Express 
Edition 2004 client files are stored on 3.5-inch disks or other external storage media.

Tip: The default installation location for the ProSeries Express Edition 2004 client file 
directory was C:\ExpWin04\04Data.
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Know the location of the other important data files

If you use QuickBooks® software or any other software from which you expect to import 
client data, make sure you know where the relevant data files are located.

Installing ProSeries Express Edition 2005 software

You install ProSeries Express software from the first ProSeries Express CD that you receive. 
Each ProSeries Express CD contains the latest version of each ProSeries Express tax 
product that’s currently available. (For details about each ProSeries Express CD, see 
“Software service and delivery information” on page 27.)

When you run the ProSeries Express installation program, select each ProSeries Express 
tax product that you expect to use for the 2005 tax year. The installation program installs 
each tax product that you selected, provided the tax product is on the ProSeries Express 
CD. The ProSeries Express Edition User’s Guide is also installed.

Important: We strongly recommend that you install ProSeries Express when you receive 
the ProSeries Express CD so you can receive other products via the Internet as soon as 
possible. For more information, see “Keeping your ProSeries Express Edition tax products 
up-to-date” on page 27.

Before you install ProSeries Express software for the 2005 tax year, note the following 
important information:

● Release Notes. Read the printed Release Notes and any other material that 
accompanied the ProSeries Express CD.

THE RELEASE NOTES MAY CONTAIN, AMONG OTHER THINGS, ADDITIONAL 
LICENSING TERMS THAT GOVERN THE USE OF THE PROSERIES EXPRESS 
SOFTWARE AND RELATED SERVICES.

● Packing slip. The packing slip that accompanied the ProSeries Express Edition CD 
contains your ZIP code and Customer Number, which you will need during 
installation.

Installing ProSeries Express software for stand-alone use

Important. If you’re installing ProSeries Express Edition software for network use, refer 
to the installation instructions in the ProSeries Express Edition Network Installation 
Guide.

To install ProSeries Express software on a computer for stand-alone use:

1 Close all open applications and turn off any virus-protection utilities on the 
computer.

2 Insert the ProSeries Express CD into the appropriate drive.

Don’t remove the CD from the drive until you finish installing products.

3 In the ProSeries Express Installation dialog box, click Tax Preparation.

If the ProSeries Express Installation dialog box doesn’t appear automatically:

a. Go to the Windows taskbar, select Start, then select Run.

b. In the Run dialog box, type X:\CDSETUP (where X represents the letter of 
the drive containing the ProSeries CD), then click OK.

c. When the ProSeries Express Installation dialog box opens, select Tax 

Preparation, then continue to Step 4.
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4 In the Welcome dialog box, click Next when you’re ready to continue.

5 A System Warning dialog box opens if your computer doesn’t meet the minimum 
system requirements for the ProSeries Express 2005 software. (For more information, 
see “Computer system requirements for stand-alone computers” on page 2.)

If the System Warning dialog box opens, read the information, then do one of the 
following:

• Click Cancel to exit the installation program, then correct the situation(s) 
identified in the System Warning dialog box. After your computer meets the 
minimum system requirements for the ProSeries Express 2005 software, start the 
installation procedure with Step 1 on page 8.

• Check the box indicating that you understand you may not receive technical 
support for issues that you may encounter while using the ProSeries Express 
program, then click Next to continue to Step 6.

Important: We strongly recommend that you click Cancel and correct the 
situation(s) identified in the System Warning dialog box. For information about 
how system requirements can affect the operation of ProSeries Express, go to 
http://www.proseries.com.

6 In the Software License Agreement dialog box, read the ProSeries Express License 
Agreement to understand the scope of your rights to use ProSeries Express software.

• Select I accept the terms of the license agreement if you agree to accept all the 
terms of the ProSeries Express License Agreement, then click Next and continue 
to Step 7.

• Select I do not accept the terms of the license agreement if you don’t agree to 
accept all the terms of the ProSeries Express License Agreement, then click Cancel 
and exit the installation program.

Important: If for any reason you find the terms of the ProSeries Express License 
Agreement unacceptable, do not install the software. Contact ProSeries Express 
Customer Service for a refund instead.

7 In the Select an Installation Type dialog box, select Stand Alone, then click Next.

8 In the Select Destination Directory dialog box, do one of the following:

• Click Next if you want to install ProSeries Express Edition software in a 
\EXPWIN05 directory on the drive that’s shown in the dialog box. (That drive 
will be C: or the drive on which last year’s ProSeries Express Edition software was 
installed.) Proceed to Step 10.

• Click Browse if you want to install ProSeries Express Edition software to a 
different drive or directory. Continue with Step 9.

Stand Alone is the default 
selection.

If you select Network, see the
ProSeries Express Edition 
Installation Guide.
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9 In the Select Folder dialog box, take the following steps:

a. Select the drive where you want to install ProSeries Express software.

b. After selecting the drive, type the folder name ExpWin05 in the Folder 
name field so that it opens after the drive you selected, then click OK.

EXPWIN05 directory. For best results, use EXPWIN05 as the name of 
your 2005 ProSeries Express directory. Don’t install ProSeries Express 
software to the root of a drive.

c. When prompted to create the EXPWIN05 directory in the location that 
you’ve specified, click Yes.

d. When you return to the Select Destination Directory dialog box, click 
Next. Continue with Step 10.

10 In the Tax Year 2005 Product Selections dialog box, select the products that you 
expect to use for the 2005 tax year, then click Next.

Tip: If you used ProSeries Express Edition software for the 2004 tax year, the 
products that were installed last year may already be selected.

Click here if you want to install your 
ProSeries Express products on a 
drive other than the drive that’s 
shown.

See Step 9 for additional 
instructions.

This section explains 
how to use this dialog 
box.

These check boxes are 
for federal products.

At least one federal 
product must be 
selected.

Tip: If you select a 
state product, be sure 
to select the 
corresponding federal 
product.

These check boxes are for state products.
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Tip: Every ProSeries Express Edition tax product for 2005 is shown in this dialog 
box, including products that may not be available yet. Select all ProSeries Express tax 
products that you intend to use this tax season. You can install additional products 
later, as described in “Keeping your ProSeries Express Edition tax products 
up-to-date” on page 27.

11 If any of the products you selected aren’t on the CD, you’ll see the Installation Note 
dialog box. Review the list of products that will be installed later (when they become 
available), then click OK. (For more information, see “Keeping your ProSeries Express 
Edition tax products up-to-date” on page 27.)

12 In the E-mail Alert Registration dialog box, click Accept or Decline, depending on 
whether you accept the terms of the E-mail Alerts system, then click Next.

Tip: E-mail alerts inform you when the products you selected for installation 
become available or are updated. E-mail alerts also inform you about support issues, 
and include information relevant to your ProSeries Express products.

13 Review the E-mail Alert Selection on Multiple Computers dialog box, then click OK.

14 In the Installation Details dialog box, review all the information, including the disk 
space information, then click Next.

The installation program installs all available ProSeries Express Edition tax products 
that you selected, then verifies that all applicable files were installed correctly. 
Continue with Step 15.

Installation Failed dialog box. If you see this dialog box, a product was not installed 
properly. Click Help to find a possible solution, then click Exit to exit the installation 
program.

15 Additional components. Wait while additional components, such as any necessary 
fonts, Internet Client software, the ProSeries Express Edition User’s Guide, and 
ProSeries Express Product Licensing components are installed. Dialog boxes and 
progress bars keep you informed.

16 Internet Explorer. If Microsoft Internet Explorer 5.5, service pack 2 or later isn’t 
installed on your computer, the installation program installs Internet Explorer 6.0 
before continuing. ProSeries Express Edition software requires portions of Internet 
Explorer 5.5, service pack 2 or later to run properly.

Important: If the installation program installs Microsoft Internet Explorer, you are 
prompted to restart your computer. After the computer restarts, the installation 
program will finish the ProSeries Express installation procedure.

17 Restart Windows message. Restart your computer if you are prompted to do so.

If the installation program doesn’t resume after you restart the computer, 
start the ProSeries Express program by double-clicking the ProSeries 

Express Edition 2005 shortcut icon on your Windows desktop. The 
Connected Customer Wizard will begin automatically. Go to “Setting up 
the ProSeries Express Edition program” on page 12.

18 Setup Complete. In the Setup Complete 
dialog box, click Finish, then continue with 
Step 19.

We recommend that you leave the check 
mark in the Launch ProSeries Express 
option.

19 If the Launch ProSeries option was selected: 
The Connected Customer Wizard begins 
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automatically. Proceed to “Setting up the ProSeries Express Edition program” on 
page 12.

If the Launch ProSeries option wasn’t selected: You return to the ProSeries Express 

Installation dialog box. Click Exit to return to the Windows desktop.

20 After you return to the Windows desktop, start the ProSeries Express program by 
double-clicking the ProSeries Express Edition 2005 shortcut icon. The Connected 
Customer Wizard begins automatically.

21 Continue with “Setting up the ProSeries Express Edition program” below.

Setting up the ProSeries Express Edition program

The first time that you start the ProSeries Express Edition program, the Connected 
Customer Wizard helps you set up the program if there’s a valid Internet connection.

Network. The ProSeries Express program should start from the ProSeries Express Admin 
workstation the first time. Don’t set up other workstations to run the program until 
you’ve set up ProSeries Express from the ProSeries Express Admin workstation.

If the computer has a valid Internet connection

If the computer has a valid Internet connection, the Connected Customer Wizard 
performs the following important tasks to save you time:

● Internet Connection. Connects via the Internet to an Intuit Internet server 
containing customer information.

● Firm information. Retrieves the name and address of your firm from the Intuit 
Internet server.

● E-mail address. Retrieves your firm’s e-mail address from the Intuit Internet server.

● Product licensing. Licenses your ProSeries Express tax software to your firm, based on 
your Customer Number, ZIP code, and information in the customer database on the 
Intuit Internet server.

• Products you’ve purchased as Unlimited are licensed as Unlimited.

• All other products are licensed as Pay-Per-Return.

• Network version. If you’ve purchased ProSeries Express Edition/Network Version, 
the program is licensed for network use. For more information, see the ProSeries 
Express Edition Network Installation Guide.

Important: Product licensing information is not printed on the packing slip. For 
more information, see “Product licensing” on page 25.

● Product updates. Checks for updates to the products that were installed from the 
ProSeries Express CD, then downloads and applies the relevant updates, if any.

● New products. Checks for products that you selected for installation that weren’t 
installed from the ProSeries Express CD, then downloads and installs those products, 
if any.

Tip: If you need to edit information that the Connected Customer Wizard retrieves from 
the Intuit Internet server, you can do that in the ProSeries Express Edition program later. 
Go to “Using the Connected Customer Wizard” on page 13.

If the computer doesn’t have a valid Internet connection

If the computer doesn’t have a valid Internet connection, you see a dialog box that 
explains the benefits of being connected and asks whether you want to start the Internet 
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Connection Setup Wizard. If you don’t establish a valid Internet connection, the Options 
Setup Wizard begins. Proceed to “Setting up ProSeries Express Edition options” on 
page 16. You’ll have an opportunity to license your products and to enter your firm’s 
name and address later.

Using the Connected Customer Wizard

When the Connected Customer Wizard starts, go to:

• Step 1 if the computer doesn’t have a valid Internet connection

• Step 2 if the computer has a dial-up Internet connection

• Step 3 if the computer has a valid, non-dial-up Internet connection

1 If the computer doesn’t have a valid Internet connection, a dialog box explains the 
benefits of being connected.

• If you think you might be able to establish a valid Internet connection, click Yes 
to run the Internet Connection Setup Wizard.

After you establish a valid Internet connection and return to the 
Connected Customer Wizard, continue with Step 2.

• If you know you won’t be able to establish a valid Internet connection now, click 
No to exit the Connected Customer Wizard.

The ProSeries Express program will start automatically. Proceed to “Setting 
up ProSeries Express Edition options” on page 16.

Tip: To establish a valid Internet connection at a later time, go to the 
ProSeries Express Help menu and select Internet Connection Setup.

2 If the computer has a dial-up Internet connection, you are prompted to connect to 
the Internet if the computer isn’t currently connected. After you connect to the 
Internet, continue with Step 3.

3 In the Connected Customer dialog box, click Choose Products to Install if you want 
to view the products that you selected to install, or if you want to select additional 
products for installation.

Click Next in the Connected Customer dialog box when you’re ready to continue to 
Step 4.

4 The Customer Information dialog box opens so you can enter or verify your 
Customer Number and ZIP code. That information is printed in the Sold To: area in 
the upper-left corner of your ProSeries Express packing slip.

Click here to view the Tax Year 
2005 Product Selections dialog 
box.

Click Next to continue.



14 ProSeries Express Edition Quick Reference Guide 2005

5 Click Next.

The Progress dialog box keeps you informed about what the Connected Customer 
Wizard is doing.

• The Connected Customer Wizard adds a check mark when it successfully 
completes a task.

• If the Connected Customer Wizard is unable to complete a task, you’ll see an “X” 
instead.

6 Click Next after the Connected Customer Wizard finishes the setup tasks.

7 In the Verify Firm Information dialog box, review the information that appears. This 
is the information that we have on file for your firm (based on your Customer 
Number and ZIP code).

Important: Review this information carefully. The ProSeries Express program prints 
this information on all returns prepared by your firm.

These numbers should match the 
Customer Number and ZIP code 
printed in the Sold To area of your 
packing slip.

A different Customer Number and 
ZIP code might appear in the Ship To 
area of your packing slip.
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8 Click Next.

• If you selected Yes, you see the Verify EMail Address dialog box. Skip to Step 10.

• If you selected No, you see the Enter Firm Information dialog box. Continue with 
Step 9.

9 In the Enter Firm Information dialog box, enter or edit your firm’s name and address, 
then click Next.

10 In the Verify EMail Address dialog box, enter or verify your e-mail address, then 
click Next.

11 The Sending Changes to Server dialog box keeps you informed about what the 
Connected Customer Wizard is doing. When it’s done, click Continue.

12 The ProSeries Express Edition program checks for any new product releases and 
product updates.

Click Yes if your firm information is 
correct.

Click No if you want to enter or edit 
your firm information.

ProSeries Express 
Edition program checks 
for product updates
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13 If there are new products or product updates to download, wait while the Connected 
Customer Wizard downloads and installs those new products and product updates.

14 When the Connected Customer Wizard finishes, the Prior Year Settings Transferred 

dialog box opens or the Options Setup Wizard begins so you can set up various 
ProSeries Express Edition options. Go to “Setting up ProSeries Express Edition 
options” next.

Setting up ProSeries Express Edition options

You can set up ProSeries Express options by simply going to the Tools menu and choosing 
either Options or Options Setup Wizard, as described in this section.

Using the Options dialog box

You can use the Options dialog box to select or change all program options, including 
those that you cannot select or set up using the Options Setup Wizard.

1 From the Tools menu, select Options.

The Options dialog box opens with General selected (in most situations).

2 Click the other selections on the left side of the Options dialog box to see the 
different categories.

The ProSeries Express 
Edition program displays 
the status of the product 
updates.

Click Close.
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3 Press ENTER or TAB, or use your mouse to move to new fields.

4 To get help, click the Help button.

5 After you finish making selections, click OK to save them.

Using the Options Setup Wizard

Using the Options Setup Wizard is the easiest way to set up ProSeries Express options. 
This section describes some of the ProSeries Express Edition features that you can set up 
using the wizard.

1 From the Tools menu, select Options Setup Wizard.

2 When the Options Setup Wizard starts, the first dialog box you see welcomes you to 
the Options Setup Wizard. Continue to click Next after setting up options in 
subsequent Options Setup Wizard dialog boxes.

Most Options Setup Wizard dialog boxes are self-explanatory. However, the next 
sections discuss the following topics in some detail.

• “Entering firm and preparer information” (see page 18)

• “Setting up multiple preparers with electronic filing identification numbers” (see 
page 18)

• “Setting up a Service Bureau” (see page 18)

• “Adding an additional firm or Electronic Return Originator (ERO)” (see page 19)

• “Installing ProSeries Express on more than one computer” (see page 20)

• “Entering bank products registration information” (see page 20)

• “Entering global billing information” (see page 21)

• “Selecting a printer” (see page 21)

• “Registering for bank products through Santa Barbara Bank & Trust and Refund 
Infoline” (see page 22)

• “Completing the setup wizard” (see page 22)

3 Click Finish to save the options that you selected.

When you 
click a 
selection on 
the left side 
of the 
Options 
dialog box, 
that category 
of options 
opens in the 
right side of 
the dialog 
box.

Click the Help 
button if you 
want more 
information 
about the 
currently-
selected 
section in the 
Options 
dialog box.
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Entering firm and preparer information

You enter information about your firm in the Firm/Preparer Information dialog box. If 
you completed the Connected Customer Wizard described on page 13, you’ll see your 
firm’s name and address in the gray area of the Firm Information section.

Tip: If you don’t see your firm’s name and address, you’ll retrieve that information from 
an Intuit Internet server later, as explained in “Product licensing” on page 25.

Enter other information about your firm in the fields below the gray area. If the firm will 
be filing returns electronically, be sure to enter the firm’s Electronic Filing Identification 
Number (EFIN).

Tip. To move to new fields, press ENTER or TAB, or use your mouse.

Enter information about the firm’s preparers, including tax preparers with their own 
electronic filing identification number (EFIN). There’s room to enter information for 
many preparers. If preparers will be filing returns electronically, enter Electronic Return 
Originator (ERO) information in this section also. If the ProSeries Express program 
transferred preparer information from last year’s ProSeries Express Edition program, just 
edit the information as necessary.

Tip: For information about any field in the Firm/Preparer Information dialog box, right 
mouse click the field, then select About <Field> on the pop-up menu.

Setting up multiple preparers with electronic filing identification numbers

ProSeries Express Edition software allows your firm to electronically file tax returns using 
more than one electronic filing identification number (EFIN). With multiple EFIN 
capability, your firm can transmit tax returns and receive acknowledgements for each tax 
preparer’s EFIN simultaneously as long as the tax preparer is a member of the firm. Enter 
each preparer’s information separately in the Preparer/ERO Information section.

Setting up a Service Bureau

You’ll use the Service Bureau Information dialog box to enter important information 
about your Service Bureau, including a Master Electronic Filing Identification Number 
(EFIN) and/or IRS Intermediate Service Provider EFIN/SBIN.

1 Verify that your firm’s name and 
address have been retrieved from 
an Intuit Internet server.

2 Enter other information about 
your firm.

3 Enter the firm’s EFIN and the first 
and last name of the electronic 
filing contact person.

4 Enter preparer and ERO 
information including multiple 
EFINs in this section. Use the 
scroll bar to add more EROs or 
add’l firms.

You’ll use this dialog box to set up 
firm information, multiple EFINS, and 
electronic filing contact information.
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Setting up a Service Bureau or IRS Intermediate Service Provider lets you use the ProSeries 
Express Edition software to transmit tax returns on behalf of another ERO who has an 
EFIN but does not necessarily electronically file returns for his or her clients.

When your firm operates as a Service Bureau, you can collect fees for your services from 
the individual ERO’s bank product returns transmitted from your Service Bureau using 
the ProSeries Express Edition software. If you use Santa Barbara Bank & Trust as your bank 
products provider, fees are generally split between the tax preparer and the Service Bureau 
that provided a value-added service for the preparer of the return.

To enter your Service Bureau information:

1 In the Service Bureau Information dialog box, enter your master EFIN and the 
service bureau fee that you want to charge. You can enter a service bureau fee 
without setting up additional EROs or firms.

2 Use the check boxes in the Service Bureau table to assign individual EROs the firm's 
master EFIN, or the Intermediate Service Provider EFIN or Service Bureau 
Identification Number (SBIN).

3 If the Electronic Return Originators that you’d like to include are not listed, follow 
the steps below to add additional firms or Electronic Return Originators (ERO).

4 Click Next.

Adding an additional firm or Electronic Return Originator (ERO)

You'll use the Firm/Preparer Information dialog box to add multiple firms and electronic 
return originators in the ProSeries Express Edition program.

1 Go to the Tools menu and select Options.

2 Select Firm/Preparer Info. The Firm/Preparer Info dialog box opens.

3 In the Firm/Preparer Info dialog box, press the CTRL+SHIFT keys on your keyboard, 
then click the Edit button. The Additional Firm Information dialog box opens.

4 In the Additional Firm Information dialog box, click the Add button. The Add New 

Firm Information dialog box opens.

5 Enter the information about the new firm that you want to add to ProSeries Express 
Edition.

6 Before you close the Add New Firm Information dialog box, call ProSeries Customer 
Service at 1-800-374-7317 during business hours to obtain a “key,” which enables 

1 Enter the firm’s Master 
EFIN.

2 Enter the firm’s Service 
Bureau fee.

3 Enter the firm’s Service 
Bureau Identification 
Number (if registered 
with the IRS).

4 Enter an additional ERO 
or assign an individual 
ERO the firm’s Master 
EFIN or SBIN.
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you to enter additional firm information. When the ProSeries customer service agent 
assigns you a key, make sure that you write down the key and keep it in a safe place. 
You may need to use the key again in the future. 

7 Enter the key that you were assigned in the “Key” box, then click OK to close the 
dialog box. You can now close the Additional Firm Information dialog box.

8 To verify that the new firm information has been added to the ProSeries Express 
program, select Firm/Preparer Information. You should be able to view the new firm 
information that you added in the “Additional Firm Information” section. However, 
if you want to change the Firm/Preparer Information, you'll need to fax a request to 
ProSeries Customer Service at 1-800-568-7963. You'll want to make sure that you 
include the new and the old address of the firm/preparer information in your fax.

9 Click OK to save your selections.

Installing ProSeries Express on more than one computer

If you are installing the stand-alone version of ProSeries Express Edition software on more 
than one computer, it’s recommended that you assign a different Declaration Control 
Number (DCN) on each installation of the ProSeries Express Edition software that you 
have in your office. If client tax returns with duplicate DCNs are detected, the ProSeries 
Express Edition software cannot transmit the returns to the Intuit Electronic Filing 
Center.

Entering bank products registration information

Enter your firm’s electronic filing information and bank information in the Bank 

Products Registration Information dialog box.

Type any number to change the DCN 
for the ProSeries Express Edition 
software installed on this computer.
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Entering global billing information

Use the Global Billing Options dialog box to set the billing options that you want to use 
for all clients. Many billing options are available. If the ProSeries Express Edition program 
transferred global billing information from last year’s ProSeries Express Edition program, 
just edit the information as necessary.

Important: For detailed information about any field in the Global Billing Options dialog 
box, right mouse click the field and select About <Field> in the pop-up menu.

Selecting a printer

Use the Select a Printer dialog box to choose a specific printer in your office where you 
want to print tax forms, client letters, labels, and refund checks for bank products.

You entered your firm’s 
EFIN and EIN in the 
Firm/Preparer Info 
dialog box.

You must provide an 
EIN or a SSN, but you’re 
not required to provide 
both numbers.

The Fax field can be 
blank.

Global Billing Options has 
seven sections:

• Tax Preparation Fees
• Hourly Charges
• Per Form Charges
• Miscellaneous Fees and 

Adjustments
• Discount
• Sales Tax
• Standard Paragraph
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Registering for bank products through Santa Barbara Bank & Trust and 
Refund Infoline

Use the Register for Bank Products through SBBT and Refund Infoline dialog box if you 
want to use Santa Barbara Bank & Trust as your bank products provider. Select the 
Register for ProSeries Express Bank Products check box to transmit your bank products 
registration information to Santa Barbara Bank and Trust and receive a registration 
complete status message from them.

Important. You must register with Santa Barbara Bank & Trust before attempting to 
transmit your first client’s bank product return for TY05.

Select the Register for ProSeries Express Refund Infoline to register for Refund Infoline. 
For more information about Refund Infoline, see “More about Refund Infoline” on 
page 46.

Tip: The Intuit Electronic Filing Center opens for registration on December 1, 2005.

Completing the setup wizard

When the Options Setup Wizard finishes, you’ll see a Congratulations! dialog box.

Select the Change 
button to choose 
a printer for 
printing tax 
forms, client 
letters, labels, and 
refund checks.

Select this check box to 
register for bank 
products through Santa 
Barbara Bank & Trust

Select this check box to 
register for ProSeries 
Express Refund Infoline.
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When you click Finish, the ProSeries Express Edition program opens an Enroll Online 
dialog box that allows you to enroll with Santa Barbara Bank & Trust to offer bank 
products to your clients. You can also order checks and supplies for the upcoming tax 
season.

Transferring data from ProSeries Express 2004 
client files

The transfer procedure is a simple way to start your clients’ ProSeries Express Edition 
2005 client files using the relevant data in their ProSeries Express Edition 2004 client files.

When you complete the Options Setup Wizard, you are asked if you want to transfer last 
year’s client files.

If you used ProSeries Express Edition software last year, click Yes to go to the Transfer 
window, then do the five steps listed on the left side of the Transfer window.

Click Finish to complete 
the Options Setup 
Wizard.

To enroll with the Santa Barbara 
Bank & Trust bank products 
program, click this link.
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Important: When transferring client data on a network, you must select the directory 
where your ProSeries Express Edition 2005 client files are being saved. This directory is set 
from the ProSeries Express Admin workstation during the Options Setup Wizard (or in the 
Directories section of the Options dialog box).

When you click Transfer, the ProSeries Express Edition program creates a new 2005 client 
file for each client whose data is being transferred, then transfers the applicable data into 
the new ProSeries Express 2005 client file.

The Batch Transfer Status dialog box keeps you informed during the Transfer process, 
and the Transfer Log dialog box opens when the ProSeries Express program finishes 
transferring client data. Review the information, then click Close to go to HomeBase. 
HomeBase is discussed in “Preparing client tax returns” on page 29.

Electronic filing. If a 2004 return was marked for electronic filing, that selection is 
transferred to the 2005 return. If a client’s 2005 federal return will be electronically filed 
using a Practitioner PIN instead of Form 8453, open the client’s 2005 federal return, and 
go to the Federal Information Worksheet. In Part IV - Filing Information, scroll down to 
the Practitioner PIN program section, then click the QuickZoom to the IRS e-file 

Authentication Statement button. You’ll need to retain a completed copy of Form 8879, 
IRS e-file Signature Authorization, that’s been signed by the client.

Important: If your firm will be filing returns electronically from more than one 
computer using the same EFIN on each one (and the program is installed for stand-alone 
use on each computer), change the starting number in the DCN counter on all but one 
computer before opening any returns. For more information, see “Setting up the DCN 
counter on multiple stand-alone computers” on page 34.

Tip: For more information about transferring data from ProSeries Express Edition 2004 
client files, use the Search Help feature on the Help pane to find the information that you 
want.

1 Select the type of 
transfer you want to 
perform from the list
of alternatives.

2 Select the location of 
your existing client 
files.

3 Select a location for 
the new client files.

4 Select the client files 
that you want to 
transfer data from, or 
click the Select All 
button.

5 After you’ve selected 
one or more clients, 
click Transfer.
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Product licensing

Product licensing is a system that licenses your ProSeries Express tax software to your 
firm. Product licensing is required before you can print returns or file returns 
electronically, or create PDF files that contain returns. Products that aren’t licensed for 
unlimited use can be used on a Pay-Per-Return basis. Product licensing no longer requires 
access codes.

Product licensing uses your Customer Number and ZIP code with information in Intuit’s 
records to deliver the following to your ProSeries Express tax software:

● An unlimited-use license for each ProSeries Express Edition tax product and ProSeries 
Express Edition electronic filing product that you’ve purchased for Unlimited use—
even if those products haven’t been installed yet (except 706 and 709 products)

● Your firm’s name and address

● A network license (if you purchase ProSeries Express Edition/Network Version

ProSeries Express Edition product licensing can be performed using the Online method or 
the Manual method. For most ProSeries Express Edition users, product licensing occurs 
online automatically.

Automatic, Online product licensing

The Connected Customer Wizard performs product licensing automatically when:

● You install ProSeries Express tax software for stand-alone use on a computer that has 
an Internet connection

● You install ProSeries Express tax software for network use from a computer (referred 
to as the ProSeries Express Admin workstation) that has an Internet connection

Important: When ProSeries Express Edition software is installed for network use, 
product licensing must be initiated from the ProSeries Express Admin workstation. 
Product licensing information is shared by all computers that have been set up as 
ProSeries Express workstations. See the ProSeries Express Edition Network Installation 
Guide for more information.

Product licensing using the Manual method

If automatic, Online product licensing hasn’t been performed (as explained above), you’ll 
see the message “Product Licensing Required” in the HomeBase Message Center. When 
you click that message, you see a License Products dialog box that includes two options: 
Online (Recommended) and Manual. Select Manual, then click OK. You’ll see the License 

Products dialog box shown on the next page.

Tip: You can contact Intuit for manual product licensing using:

• Automated Touch Tone phone service (call 1-800-723-0692)

• Online service (go to http://www.proseries.com and select Product Licensing)

• A Customer Service representative (call 1-800-557-5798)
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Be sure to read “Updating your firm’s product licensing information” on page 26.

Product licensing with multiple, non-Internet computers

If you install ProSeries Express for stand-alone use on computers that don’t have an 
Internet connection and you don’t want to perform product licensing for each computer 
using the Manual method, here’s a convenient way to copy your firm’s product licensing 
information from one computer to the other computers.

1 From the computer with your firm’s product licensing information, go to the File 
menu, select Copy Product License, then use the dialog box to save the product 
license file to a network location or removable media (such as a 3.5-inch disk).

2 From each computer that requires product licensing, go to the File menu, select 
Retrieve Product License, then use the dialog box to retrieve the product license file 
that you copied to the network location or removable media.

Tip: Repeat this procedure if you update the firm’s product licensing information.

Updating your firm’s product licensing information

Update your firm’s product licensing information when:

● You purchase additional ProSeries Express tax products or additional ProSeries 
Express electronic filing products for Unlimited use, or

● You purchase ProSeries Express Edition/Network Version, or

● The software or an Intuit ProSeries representative instructs you to update your 
product licensing information

If either of these situations occur, go to the Tools menu, select License Products, select 
Online or Manual, then click OK. If you chose Online, simply wait for the product 
licensing procedure to conclude. If you chose Manual, just follow the instructions in the 
License Products dialog box.

1 Verify your Customer Number and ZIP 
code.

2 Enter your firm’s name and address.
(This information must match the 
information contained in Intuit’s 
records.)

3 Click the Get Key Code button so the 
program will generate a unique Key 
Code.

4 Contact Intuit using one of three 
methods. After you provide the Key 
Code that was generated, you will 
receive a unique Licensing Code from 
Intuit.

5 Enter the Licensing Code, then click OK.
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Keeping your ProSeries Express Edition tax 
products up-to-date

You can install new products and update previously-installed products via the Internet 
and from ProSeries Express Edition CDs that you receive, as explained in this section. 
Getting tax products and updates via the Internet helps you have the most up-to-date 
versions of the ProSeries Express tax products that you use.

Software service and delivery information

ProSeries Express Edition software is delivered on five CDs during the tax season as 
shown in the following table.

Note: Actual shipping dates are subject to change.

For information on release dates and news specific to the products you purchase, log in to 
your personalized http://www.my.proseries.com page. For other information about 
product release dates, go to http://www.proseries.com/support/release_dates.aspx.

Step 1 - Get products and updates via the Internet

In between CD shipments, you can use the Internet to get any newly-released products 
and product updates. As soon as a ProSeries Express tax product or tax product update 
becomes available, it is posted to the Intuit Internet server.

Task Scheduler provides the easiest way to get ProSeries Express tax products and tax 
product updates via the Internet. To use Task Scheduler, take the following steps from 
each computer on which the ProSeries Express program is installed for stand-alone use 
and the ProSeries Express Admin workstation if the ProSeries Express program is installed 
for network use.

1 Go to the Tools menu, select Options, then select Task Scheduler on the left side of 
the Options dialog box.

2 Enable the Download New/Update Existing Products task. (There’s a check in the 
box before the task when it’s enabled.)

3 If you want to change the Task Scheduler schedule, click Modify, then select the 
day(s) and times that are convenient for you.

4 Make sure the computer is on when Task Scheduler is scheduled to perform tasks.

Password. Task Scheduler must be able to connect to the Internet “unattended.” If 
your Internet connection requires a password, that password must be stored and 
available.

ProSeries Express CD name Approximate ship date

Tax Release 1 CD - Draft 1040 only Week of November 28, 2005

Tax Release 2 CD Week of January 2, 2006

Tax Release 3 CD Week of January 30, 2006

Tax Release 4 CD Week of February 20, 2006

Tax Release Archive CD Week of May 1, 2006
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Tip: To get ProSeries Express tax products and tax product updates via the Internet, go to 
the Update menu and select Update Installed Products to update ProSeries Express 
Edition products, or Select and Download New Products to download new ProSeries 
Express Edition products.

Step 2 - Get products and updates from ProSeries Express 

Edition CDs

You can install ProSeries Express tax products and tax product updates from ProSeries 
Express Edition CDs that you receive after you’ve installed the program from the first 
ProSeries Express Edition CD.

1 Insert the ProSeries Express Edition CD into your CD drive.

2 Allow the installation program to install the appropriate ProSeries Express tax 
products and tax product updates from that ProSeries Express CD. You can select 
additional products for installation from the Tax Year 2005 Product Selections dialog 
box.

Tip: The on-screen ProSeries Express Edition User’s Guide will be updated, if applicable.

Network. When a ProSeries Express tax product is installed or updated on the network 
drive from the ProSeries Express Admin workstation, it becomes available to all 
workstations on which you installed and set up the ProSeries Express program.

Important: The ReadMe information for the initial release of a ProSeries Express Edition 
tax product identifies any forms that are not ready to be filed yet. If you print a form that 
can’t be filed yet, the printed form includes a “DO NOT FILE” watermark. Do not file a 

return if any of the printed forms includes a “DO NOT FILE” watermark. The ReadMe 
information for subsequent releases of a product identifies forms that can now be filed 
with the current release.

For more information about keeping your ProSeries Express tax products up-to-date, use 
the Search Help feature on the Help pane.
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Preparing client tax returns

When you complete the first-time start-up procedures, you see HomeBase. HomeBase 
summarizes information about your clients and client files.

From HomeBase, you start new client files, open existing client files, and perform a 
variety of other tasks involving your client files, such as electronic filing. The first time 
you start the ProSeries Express program, you see client information in HomeBase only if 
you transferred information from last year’s ProSeries Express client files. As you work on 
client returns, you’ll see information about those clients in HomeBase.

To see information about the clients who meet specific criteria, click the applicable 
HomeBase View tab below the HomeBase toolbar. The ProSeries Express products that are 
installed determine which HomeBase View tabs are available. For example, after ProSeries 
Express/1040 is installed, the following three HomeBase View tabs become available:

Tip: The ProSeries Express Edition program saves the data for a client’s 2005 federal and 
state returns in one client file.

Summary of the basic steps to prepare client returns

The following table presents a brief summary of the basic steps to prepare client returns. 
Note that many optional steps aren’t included in this table.

Select this HomeBase tab To do this

1040 Prepare federal individual returns and state 
individual returns

EF Clients All electronic filing tasks

Bank Product Clients All bank products tasks

Select tab to 
see 
information 
about a 
specific set of 
clients.

Click a client 
to view a 
Client 
Summary

Double-click 
a client to 
open it.

Use the scroll 
bars to see all 
rows and 
columns of 
client 
information. 

Create New Client File HelpPrint Client ReturnGet Client Snapshot

Search Help 
content

Check the Message Center for 
important messages.
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For more information about HomeBase, starting client returns, entering client tax return 
data, saving client return data, and opening previously-saved client returns, use the 
Search Help feature on the Help pane.

To do this Do this

1. Start the client’s 
federal return from 
HomeBase

If you transferred last year’s data, select the appropriate HomeBase View 
tab, then double-click the client’s name to open the client’s file.

If you are starting a new return, click the New Client button on the 
HomeBase toolbar, then select the appropriate federal product.

The appropriate Information Worksheet opens.

2. Prepare the client’s 
federal return

a. Import - If there’s relevant client data in QuickBooks, another 
program, or W-2 data from your client’s payroll provider, go to the 
Import menu and choose the applicable command.

b. Enter data - Enter data in the applicable data fields. Double-click 
forms in the Forms Bar to see them. Import Form W-2 data when 
applicable.

c. Save the data - Click the Save Client button on the toolbar often as 
you enter data.

d. Review - Click the Check for Errors button on the vertical navigation 
bar to correct errors that the ProSeries Express program identifies.

3. Prepare the client’s 
state return

a. Go to state - Click the Switch to State/City button on the vertical 
navigation bar, then select the appropriate state.

b. Enter data - Enter data in the applicable fields on the state forms.

c. Save the data - Click the Save Client button on the toolbar often as 
you enter data.

d. Review - Click the Check for Errors button on the vertical navigation 
bar to correct errors that the ProSeries program identifies.

e. Go to federal - Click the Switch to Federal button on the vertical 
navigation bar to return to the client’s federal return.

f. Prepare additional state returns - Repeat these steps for any other 
state returns that the client must file.

4. Apply for Bank 
Products

a. Go to federal - Click the Switch to Federal button on the vertical 
navigation bar to return to the client’s federal return.

b. Open the RAL & RT Wks form in the Forms Bar.

c. Enter data - Complete the RAL and RT Worksheet.

d. Review - Click the Check for Errors button on the vertical navigation 
bar to correct errors that the ProSeries program identifies.

5. Check the client’s 
return for errors

Click the Check for Errors button. Analyze the error report and correct 
any errors found.

6. Save the client’s 
return

Click the Save Client button on the toolbar.

7. Print the client’s 
return(s)

a. Select the appropriate HomeBase View tab, then select the client in 
HomeBase.

b. Click the Print Client Return button on the toolbar.

8. File the client return 
electronically

a. Make sure each return you want to file electronically is marked for 
electronic filing on the Federal Information Worksheet, and that it 
passes return error checking and Final Review.

b. Go to HomeBase and click the EF Clients tab, then select the client’s 
return(s) you want to electronically file in the EF Clients view.

c. Click the Transmit EF Return button on the toolbar.

d. After 24 to 48 hours, click the Check EF & BP Acks button on the 
toolbar to receive an acknowledgement for the client’s return.
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Setting up other ProSeries Express Edition features

Use the information in the following table to set up these ProSeries Express Edition 
features.

For information about setting, reviewing, and changing ProSeries Express Edition 
options, use the Search Help feature on the Help pane.

Getting help in the ProSeries Express Edition 
program

The ProSeries Express Edition Help system includes a Help pane at the bottom of your 
screen with three features to help you get the information that you need quickly and 

To do this Do this

Bank Products. Apply for bank products so 
you can offer RALs, RTs, and other bank 
product services to your clients.

Go to the Bank Products section of ProSeries.com 
to learn how to enroll.

Billing clock. Activate the billing clock so it 
tracks the time you spend on each return.

Go to the Tools menu, select Billing, then select 
Billing Clock.

Billing rates. Set billing rates for the forms 
and schedules of a specific type of return.

Go to the Tools menu, select Billing, then select 
Rates Per Form.

Client template. Enter data that applies to all 
your clients who file a specific type of federal 
return.

Go to the Tools menu and select Edit Client 
Template.

Internet connection. Set up an Internet 
connection so you can use ProSeries Express 
connectivity features.

Go to the Help menu and select Internet 
Connection Setup.

Invoices. View or edit the standard invoice 
for a specific type of return.

Open a return of that type, go to the Tools menu, 
select Billing, then select View Invoice or Edit 
Invoice.

Letters. View or edit the standard client letter 
or standard recipient letter for a specific type 
of return.

Open a return of that type, go to the Tools menu, 
select Letters, then select View Client Letter or 
Edit Client Letter.

Licensing. License your ProSeries Express tax 
products so you can print and file returns 
electronically.

Go to the Tools menu, select License Products, 
then select Online or Manual.
(We recommend that you select Online.)

Pay-Per-Return. Add funds to a 
Pay-Per-Return account so you can print and 
file returns electronically (for products you’re 
using on a pay-per-return basis).

Go to the Tools menu, select Pay Per Return, then 
select Increase Account Balance.

Refund Infoline. Allows your clients to 
retrieve the status of their e-filed return or tax 
refund using a toll-free telephone number.

Go to the Tools menu, select Options, then select 
Refund Infoline.

Slip sheets. Select options for slip sheets to 
use with envelopes and presentation folders.

Go to the Tools menu and select Global Slip Sheet 
Options.

W-2 Instant Data Entry. Enables a service that 
imports your client’s W-2 information into 
an open tax return.

Go to the Tools menu, select Options, then select 
W-2 Import.
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easily. From left to right, those features are Field/Form Help, Most Common Support 
Questions, and Search Help content.

Field/Form Help

When you’re working on a client’s return, the left area of the Help pane shows 
information about the currently-selected field or form. Click the blue, underlined word 
“more” to see all the current Field/Form Help information in the Help Center. Field/Form 
Help includes Tax Help, Cross-references, and Government Instructions.

Most Common Support Questions

Most Common Support Questions are top support topics linked to information in 
ProSeries Express Help. Select a topic to see the relevant information in the Help Center.

Search Help content

To get answers to a question or information about a keyword or phrase, type the question, 
word, or phrase in the Search Help field, then press the ENTER key or click the Search 
button next to the Search Help field. The program searches ProSeries Express Help 
content, then lists the search results in the Help Center. Click the blue, underlined title of 
a search result to see the full content of that information source in the Help Center or a 
browser window.

Using the Help Center

All three features in the Help pane—Field/Form Help, Most Common Support Questions, 
and Search Help—open the Help Center. From the Help Center, you can get a variety of 
information from one, easy-to-use location.

Field/Form Help Most Common Support Questions Search Help contentHelp pane
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Tip: The Help Center opens when you click the Help button on the toolbar.

Tip: For more information about ProSeries Express Edition Help, use the Search Help 
feature on the Help pane.

Electronically filing tax returns

ProSeries Express Edition/Electronic Filing software is installed with ProSeries Express 
Edition tax products that support electronic filing. ProSeries Express Edition software 
supports electronic filing of the following:

● Federal individual returns and extension request forms

● State individual returns (for 42 states)

● Federal corporation and S corporation returns and extension request forms

● California corporation returns

● Massachusetts corporation, S corporation, partnership, and fiduciary returns

● Massachusetts corporation and S corporation extension request forms

Search for a specific topic 
in Tax Help and Program 
Help here.

Help us improve ProSeries Express help.Click and drag the splitter bar to 
adjust the window sizes.

Click a plus sign [+] to 
expand a selection.
Click a minus sign [-] to 
collapse a selection.

Use the scroll bars to see 
all the information in the 
Help Center.

Click blue, underlined 
hyperlinks to see more 
about those topics.

Click the selections on the 
left side of the Help Center 
to see the corresponding 
information to the right.
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● Michigan Single Business Tax returns

To visit the Web site for a state’s tax agency, go to http://www.proseries.com, select Tools, 
select State Tax Departments in the General Tax Resources section, then select the name 
of the state.

Important: If you don’t have an IRS-issued Electronic Filing Identification Number 
(EFIN) yet, see “Preparing for electronic filing” on page 3.

Tip: For information about electronically filing of Michigan Single Business Tax returns 
and Massachusetts corporation, S corporation, partnership, and fiduciary returns and 
extensions, use Search or see chapter 11, “Electronically filing an income tax return” in 
the ProSeries Express Edition User’s Guide.

Establishing an Internet connection

To file electronically, you need to be able to connect to the Internet from the computer 
on which the ProSeries Express Edition program is installed.

If you don’t have an Internet connection, you must first sign up for service with an 
Internet Service Provider (ISP). Once you have an ISP, go to the Help menu, select Internet 

Connection Setup, then follow the instructions in the dialog boxes.

Setting up the DCN counter on multiple stand-alone 

computers

When ProSeries Express Edition software is installed on a stand-alone computer, the DCN 
(Declaration Control Number) counter is initially set at “00001.” The ProSeries Express 
Edition program assigns that number to the first federal return that’s marked for 
electronic filing, then increments the DCN counter by “1.” As each subsequent federal 
return is marked for electronic filing, the program assigns the current DCN to that return, 
then increments the DCN counter by “1.”

Changing the starting number in the DCN counter for a computer

If your firm will be filing returns electronically from more than one computer using the 
same EFIN on each one (and these computers are not networked), you’ll need to change 
the starting number in the DCN counter in the ProSeries Express Edition program on all 
but one computer before the firm’s tax preparers start to transfer or prepare tax returns.

1 Go to the Tools menu and select Options.

2 In the Options dialog box, select Electronic Filing.

3 In the DCN Counter box, highlight a digit, then type a new number that you want to 
use, for example, “01001.”

4 To increment or decrement the counter, click the up or down arrows.

5 Click OK to save your changes.

By advancing the DCN counter sufficiently in the ProSeries Express Edition program on 
each “additional” stand-alone computer, each return marked for electronic filing will be 
assigned a unique DCN. For example, changing the DCN counter to “01001” on the 
second computer, to “02001” on the third computer, and so on.

Highlight a digit, 
then type a new 
number to change 
DCN counter

Increment or 
decrement 
counter
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Tip: If a computer will be using a unique EFIN, it’s not necessary to change the starting 
number in the DCN counter for that computer.

Steps to electronically file a tax return

You’ll follow these basic steps when filing your clients tax returns electronically.

Step 1 - Mark the return for electronic filing

To mark a client’s federal and state returns for electronic filing:

1 Open the client’s federal return, go to the Federal Information Worksheet, scroll 
down to Part IV - Filing Information, then make sure that the appropriate preparer 
code is entered in the Preparer Code field.

Tip: Enter your preparer code in the Electronic Return Originator Information 
section of the Electronic Filing Information Worksheet. If you’re acting as an ERO 
and filing a return for another preparer, enter that preparer’s preparer code in the 
Preparer Code field.

2 Make sure the Check this box to file the federal return electronically box is checked.

3 State returns. If you’re going to file the client’s state return (or returns) 
electronically, select the check box to file state returns electronically, then enter the 
appropriate information in the Select the state or states to file electronically 
expanding table.

4 Enter all other relevant information in the Filing Information section.

Check this box to file the federal return electronically.

Enter 
information 
about the 
state return(s) 
for electronic 
filing in this 
expanding 
table.

See Help if 
you need 
assistance.

Enter the Preparer Code here.

Check this box 
to file the 
state return 
electronically.
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5 Direct Deposit/Direct Debit. If the client wants their refund deposited directly into 
their account or the balance due withdrawn from their account, complete Part V - 

Direct Deposit or Electronic Funds Withdrawal Information.

Enter 
information 
for the 
Practitioner 
PIN 
Program.

Check this 
box to use 
direct deposit 
of any federal 
refund.

Check the 
appropriate 
box in this 
area to use 
electronic 
funds 
withdrawal of 
a federal 
balance due 
(if using 
electronic 
filing).

Be sure to 
complete the 
rest of Part V.
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Step 2 - Prepare the client’s return(s) for electronic filing

To prepare a client’s return(s) for electronic filing:

1 Complete the client’s federal return.

2 Complete the Electronic Filing Smart Worksheets on the client’s Form W-2, 1099-R, 
W2-G, and 1099-G worksheets (if applicable).

3 RAL or RT. If you’re participating in the ProSeries Express/Bank Products program 
and the client wants a Refund Anticipation Loan or Refund Transfer, complete the 
applicable parts of the RAL & RT Worksheet.

For more information, see “Offering Bank Products to your clients” on page 44.

4 Click the Switch to State/City button on the vertical navigation bar.

5 Complete the client’s state return.

6 Click the Switch to Federal button on the vertical navigation bar.

7 Go to the toolbar and click the Save Client button.

Avoiding common reasons for rejection

● Verify the client’s social security number (SSN) and Date of Birth (DOB) with the 
Social Security Administration (SSA).

● If you’re preparing a Married Filing Joint return, verify that the spouse’s last name on 
the return matches the spouse’s last name on his or her Social Security card.

● Make sure the employer’s name and federal identification number on the actual 
Form W-2 match the information you’ve entered in the ProSeries Express program.

● Make sure the payer’s name and federal identification number on the actual Form 
W-2G or Form 1099-R match the information you’ve entered in the ProSeries 
Express program.

● Use the error-checking feature during data entry. Go to the View menu and make 
sure there’s a check mark before Error Alerts.

Step 3 - Check the client’s return for errors

After you complete a federal or state return, run the ProSeries Express Edition error 
checking feature to help you find errors in the client’s return.

1 To review the open federal or state return, click the Check 

for Errors button on the vertical navigation bar.

2 Analyze the error report, and fix all errors that are identified.

3 Click Recheck to check the return for errors again.

4 Not using PINs. If you’re not participating in the IRS Practitioner PIN program, 
review Form 8453 in the client’s federal return. (If you’re participating in the IRS 
Practitioner PIN program, you don’t need to file Form 8453 with the IRS.) Also 
review the electronic filing paperwork form in the client’s state return, if applicable. 
Review the form(s) and return(s) with the client.

Tip: The ERO PIN is used as an electronic signature. An ERO PIN can be any five 
digits (except all zeros). You enter your PIN in the Firm/Preparer Info section of the 
Options dialog box.
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5 Using PINs. If you’re participating in the IRS Practitioner PIN program and the client 
wants to use a PIN, open the Federal Information Worksheet. In Part IV - Filing 

Information, scroll down to the Practitioner PIN program section, then click the 
QuickZoom to the IRS e-file Authentication Statement button. When the IRS e-file 
Authentication Statement opens, make sure the check box at the top is selected, then 
complete the remainder of the form.

For more information, click the Help button while the IRS e-file 
Authentication Statement is open on the screen. Review the form and the 
return(s) with the client.

Tip: You’ll need to retain a completed copy of Form 8879, IRS e-file Signature 
Authorization, that’s been signed by the client.

Step 4 - Select a bank product

To prepare a client’s return for a Refund Anticipation Loan, a Refund Transfer, a Refund 
Transfer Direct Deposit, or other bank product:

1 In the client file, open the RAL & RT Worksheet.

2 Select a refund method and a disbursement method.

3 Click the Check for Errors button to check the return for possible errors and 
omissions. Fix any errors that are detected by the ProSeries Express Edition error 
checking feature.

4 Go to the toolbar and click the Save Client button.

5 For more information about using bank products, see “Offering Bank 
Products to your clients” on page 44.

Select a 
Refund 
method

Select a 
disbursement 
method
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Resolving duplicate Declaration Control Numbers

You cannot transmit a client’s tax return or receive acknowledgments for a tax return if it 
contains a duplicate Declaration Control Number (DCN). When the ProSeries Express 
Edition program detects a duplicate DCN, you’ll see a “Return Duplicate DCN” message 
in the Status column in HomeBase.

1 In HomeBase, select the EF Clients tab.

2 Select the Status column to sort all of the federal returns that display a Return 

Duplicate DCN status.

3 Select the client return that has a duplicate DCN.

4 Go to the E-File/Bank Products menu and select Electronic Filing.

5 Select Correct Duplicate DCNs. The Correct Duplicate DCNs dialog box opens.

6 In the Correct Duplicate DCNs dialog box, select Correct the 'Duplicate DCN' for ALL 

returns in the EF Center or Correct the 'Duplicate DCN' for highlighted returns only.

7 Click OK.

8 When the confirmation dialog box opens, click Yes.

Step 5 - Select the client return(s) to electronically file

To select client tax returns for electronic filing:

1 Go to the HomeBase EF Clients view. If HomeBase is on the screen, click 
the EF Clients tab below the toolbar. If a return is on the screen, go to the 
toolbar and click the Go to EF Clients button.

The HomeBase EF Clients view presents important information about each client 
return that you’ve prepared and marked for electronic filing, including the status of 
each return.

2 Select the returns that you want to file electronically. Their status should be Return 

Marked for EF.

Correct all returns 
with duplicate 
DCNs.

Correct the DCN for 
the client return that 
you selected.
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• To change the “Client Status” column in HomeBase, open the client’s return, then 
open the Client Status worksheet on the forms bar and choose the status that 
applies to the client’s return.

• To select consecutive client returns, select the first client return, then hold down 
the SHIFT key and select the last client return.

• To select non-consecutive client returns, hold down the CTRL key while you click 
each client return.

State returns. State returns are listed after the corresponding federal 
return. Select a client’s federal and state returns at the same time.

Tip: While California, Illinois, Maine, Massachusetts, and Minnesota 
returns do not need to be electronically filed with the corresponding 
federal return, it’s best to do so. If an Arizona, North Dakota, or South 
Carolina return isn’t filed with the corresponding federal return, it can’t be 
electronically filed until the federal return is accepted.

Step 6 - Convert and transmit the selected return(s)

To electronically file the returns that you selected in Step 5:

1 Go to the toolbar and click the Transmit EF Return button.

2 If any informational dialog boxes appear, read the information, then click 
OK.

3 In the Electronic Filing Options dialog box, select Convert and Transmit selected 

returns/extensions.

Transmit EF Return buttonThe status should be Return Marked for EF.

These 
returns are 
selected.

Client Status
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4 Make sure Enable conversion error checking is selected.

Tip: A return that cannot pass error checking will usually get rejected by the IRS. 
Therefore, do not disable conversion error checking unless directed to do so by a 
ProSeries Express Technical Support Representative.

5 Click OK.

When the ProSeries Express program finishes converting and transmitting the returns, 
the Transmit Electronic Filing Returns/Extensions Log opens so you can review the 
results.

Step 7 - Wait 24 to 48 hours, then check for 

acknowledgments

Tip: ProSeries Express Edition software automatically checks for acknowledgments when 
you transmit client returns. It may take more than 48 hours to receive an 
acknowledgment for some federal and state returns. If you are transmitting a return with 
a RAL/RT Advance, it will only take a few minutes to receive an acknowledgment.

To check for acknowledgments from the IRS or state taxing authorities:

1 Go to the same computer that you used to electronically file your client’s tax return 
(if you’re working on multiple stand-alone computers).

2 Go to the HomeBase EF Clients view. If HomeBase is on the screen, click 
the EF Clients tab below the toolbar. If you are currently working on a 
client’s return, save the file, then go to the toolbar and click the Go to EF 

Clients button.

3 Select the client’s status in the Status column of the EF Clients view to open the 
client’s Electronic Filing Client Status History.

Tip: Entries in the Status column are blue and underlined. A client’s status becomes 
bold when your mouse pointer rests on it.

4 Review the Electronic Filing Client Status History and identify the most recent status 
of the client’s return, then click Close.

Tip: If a client’s return was rejected, the report shows why it was rejected, and how 
to fix the error.

5 If the most recent status of the return is “Return Accepted,” proceed to “Step 8 - 
Complete the electronic filing process” on page 42.

If the most recent status of the return is “Return Rejected,” proceed to “Resolving a 
problem with a rejected return” on page 42.

If the most recent status of the return isn’t “Return Accepted” or “Return Rejected,” 
continue with Step 6.

Make sure there’s a 
check in this box. 
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6 Go to the E-File/Bank Products menu and select Electronic Filing.

7 From the Electronic Filing menu, select Check EF 

Acknowledgments to get the latest acknowledgments.

8 In the Receive Electronic Filing Acknowledgments 

dialog box, check the listing for electronic filing 
acknowledgments.

9 Review the information, then click Close. If the return 
was rejected, continue with “Resolving a problem with 
a rejected return” next.

Resolving a problem with a rejected return

To resolve a problem with a rejected return:

1 From the EF Clients view, go to the E-File/Bank Products menu, select to Electronic 

Filing, select Reports, then print a Rejected Returns report.

2 Incorrect SSN. If a return was rejected because the taxpayer’s social security number 
wasn’t correct, print the Intuit Electronic Postmark Report before correcting the 
social security number and resubmitting the return. This provides the original date 
and time of filing.

3 Fix the errors in the rejected return.

4 Make sure the corrected return passes error checking.

5 Convert and retransmit the corrected returns as explained in “Step 5 - Select the 
client return(s) to electronically file” on page 39 and “Step 6 - Convert and transmit 
the selected return(s)” on page 40.

Re-filing state returns. If you’ve filed a client’s federal and state returns together and 
the federal return is accepted but the state return is rejected, in most cases you can 
re-file the corrected state return electronically. However, you cannot re-file corrected 
Hawaii returns, Oklahoma returns, or Oregon returns electronically because they can 
only be filed with the client’s federal return. To re-file a corrected Hawaii return, 
Oklahoma return, or Oregon return, you must print the return, then mail it to the 
appropriate state taxing authority.

Step 8 - Complete the electronic filing process

After the IRS or state taxing authority has accepted a return, take these steps to complete 
the filing process:

1 Go to the same computer that you used to electronically file your client’s tax return 
(if you’re working on multiple stand-alone computers).

2 Not using PINs. If you and your client are not using PINs, attach any required paper 
documents to Form 8453, U.S. Individual Income Tax Declaration for an IRS e-file 
Return. Do this for each return that has been accepted, then continue with Step 3.

Tip: The Preparing Form 8453 section of the Electronic Filing Information 
Worksheet identifies the paper documents to attach to the client’s Form 8453.

Using PINs. If you and your client are using PINs, you don’t need to mail Form 8453 
to the IRS. However, you may need to mail state electronic filing paperwork to the 
appropriate state service center. Skip to Step 4.

Tip: To determine if a client’s return was filed with PINs, go to the EF Clients view 
and scroll across to the PIN column. If the return was transmitted with a PIN, you’ll 
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see a “Y” in the PIN column. If the return was transmitted without a PIN, you’ll see 
an “N” in the PIN column.

3 After you’ve been informed the federal return was accepted, mail the completed 
Form 8453 to the appropriate IRS service center within the time period required by 
the IRS.

Tip: The Mailing Form 8453 section of the Electronic Filing Information Worksheet 
shows the Form 8453 mailing address.

4 State forms. After you’ve been informed the state return was accepted, mail the 
completed state electronic filing paperwork to the appropriate state service center 
within the time period required by appropriate taxing authority (if the state taxing 
authority requires electronic filing paperwork, mail the completed state electronic 
filing paperwork to the appropriate state service center within the time period 
required after the state return is accepted).

5 Print Form 9325, Acknowledgment and General Information for Taxpayers Who File 
Returns Electronically, and give it to your client.

To print Form 9325:

a. Open the client’s federal return.

b. Go to the File menu, select Print, then select Print Selected Forms.

c. Click Choose, select Form 9325: General Information for Electronic Filers, 
then click OK.

d. Click Print.

IRS refund cycle. For information about the IRS refund cycle, go to 
http://www.proseries.com, select E-Filing, select How to E-File, then select IRS 

Refund Cycle.

6 Balance due. If you filed a balance-due return and your client did not elect to pay 
with a Discover Card or to have their bank account directly debited, print Form 
1040-V, Balance Due Payment Voucher, and give it to your client.

Federal taxes. If your client owes federal taxes, he or she must mail Form 1040-V 
and the payment to the IRS no later than April 17, 2006.

State taxes. If your client owes state taxes, complete the state tax payment voucher 
at the same time.

7 Getting current information. To review common reject reasons, troubleshooting 
information, and frequently-asked questions from http://www.proseries.com, do 
either of the following:

• While in the ProSeries Express EF Clients view, click the Help button, then click 
Quick Answers, then click Electronic filing.

• While in your Internet browser, go to http://www.proseries.com, select E-Filing, 
then select E-Filing FAQs.

Step 9 - Complete the bank product acknowledgment 

process

You can manually receive bank product acknowledgments for selected clients any time, 
even if Task Scheduler is already scheduled to check for electronic filing-related 
acknowledgments.

1 Go to the same computer that you used to electronically file your client’s tax return.

2 Select the Bank Product Clients tab.
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3 Go to the E-File/Bank Products menu, select Bank Products, then select Check Bank 

Products Acknowledgments.

The ProSeries Express Edition program connects to the Intuit Electronic Filing 
Center.

4 When the connection is complete, the Bank Products Transmission log opens, 
displaying any new authorizations and status messages you received.

• To print the contents of the log, click Print Log.

• To close the Bank Products Transmission log, click Close.

• To view detailed reasons for denial of a RAL, go to the E-File/Bank Products menu, 
select Bank Products, select Reports, then select Bank Product Denied RAL 

Report.

• To view details on accepted RALs, go to the E-File/Bank Products menu, select 
Bank Products, select Reports, then select Bank Products RAL Status Report.

• To view details on RTs, go to the E-File/Bank Products menu, select Bank 

Products, select Reports, then select Bank Products RT Status Report.

When you’re ready to print refund checks, go to the E-File/Bank Products menu, select 
Bank Products, then select Print Checks.

Refer to the next section, “Offering bank products to your clients” for more information 
about using Bank Products.

For detailed information about electronic filing, including information about filing 
Michigan Single Business Tax returns and Massachusetts corporation, S corporation, 
partnership, and fiduciary returns and corporate extensions electronically, use the Search 
Help feature on the Help pane, then go to chapter 11, “Electronically filing an income tax 
return.”

Offering Bank Products to your clients

When you file your clients’ federal individual returns electronically, those clients may be 
eligible to receive a disbursement based on their expected federal refunds in the form of 
bank products such as Refund Anticipation Loans (RALs), Refund Transfers (RTs), Refund 
Transfer Direct Deposits (RTDDs), and Advances on RALs and RTs.

New for Tax Year 2005. You can offer Pre-season RAL/RT Advances to your clients who 
want their tax refund early. You’ll be able to transmit Pre-season RAL/RT Advances using 
Santa Barbara Bank & Trust as the bank product provider as early as January 3, 2006.

Similarly, when you file your clients’ state individual returns electronically, those clients 
may be eligible to receive a disbursement based on their expected state refunds in the 
form of Refund Transfer (RT) bank products. In addition, your fees are deducted from the 
client’s refund and deposited into your bank account electronically.

You can offer bank products through Santa Barbara Bank & Trust (SBBT), which is 
integrated with the ProSeries Express Edition software, or you can offer bank products 
through First Security Bank or Republic Bank.

Tip: For more information about offering bank products through Santa Barbara Bank & 
Trust, First Security Bank or Republic Bank, see chapter 12, “Processing tax refunds using 
bank products” in the ProSeries Express Edition User’s Guide, or go to 
http://www.proseries.com.
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Summary of the basic steps to prepare bank product returns

The following table summarizes the basic steps for offering bank products to your clients 
through Santa Barbara Bank & Trust:

To take this step Do this

1. Apply to Santa Barbara Bank & 
Trust to participate in their 
bank products program.

Go to the Bank Products section of ProSeries.com to learn 
how to register.

2. Set the ProSeries Express Bank 
Products options.

a. Go to the Tools menu, select Options, then select Bank 
Products.

b. Select the Bank Products options that you want.

c. Click Registration Information, then enter the requested 
information in the Bank Products Registration 
Information dialog box.

3. Transmit your registration 
information to Santa Barbara 
Bank & Trust (any time after 
12:00 a.m. PST on 12/1/05).

a. Go to the Bank Product Clients view.

b. Go to the E-File/Bank Products menu, select Bank 
Products, then select Transmit Registration Information.

4. Check for the registration 
acceptance status from Santa 
Barbara Bank & Trust.

a. Go to the Bank Product Clients view.

b. Go to the E-File/Bank Products menu, select Bank 
Products, then select Check Bank Products 
Acknowledgments.

5. Prepare the client’s federal 
return for a bank product. If 
applicable, prepare the client’s 
state return(s) for a bank 
product.

a. Prepare the client’s federal and state return(s).

b. Prepare the client’s federal return (and state return(s) if 
applicable) for electronic filing.

c. Complete the RAL & RT Worksheet in the client’s federal 
return.

d. Review the client’s return(s) and make sure the return(s) 
successfully pass error checking.

e. Print the Refund Application Loan (RAL) and Refund 
Transfer (RT) Application and Agreement form from the 
client’s federal return, and have the taxpayer(s) sign it.

6. File the client’s return(s) 
electronically.

a. Go to EF Clients view and select the client’s return(s).

b. Early RAL/RT Advances. Go to the E-File/Bank Products 
menu, select Electronic Filing, then select Transmit Early 
RAL/RT Advance Only. Only RAL/RT Advance application 
information is sent to the bank products provider; the 
client’s tax return is not transmitted.

c. RALs, RTs, RTDDs. Go to the E-File/Bank Products menu, 
select Electronic Filing, then select Convert/Transmit 
Returns and Extensions.

7. Receive bank product print 
authorizations and status 
messages.

a. Make sure you are using the same computer that you used 
when you transmitted your client’s return in Step 6.

b. Go to the Bank Product Clients view.

c. Go to the toolbar, then click the Check EF & BP Acks 
button.

8. Activate the Refund Infoline. a. Go to the Tools menu, select Options then select Refund 
Infoline.

b. Select Enable your clients to receive e-file and bank 
product status from the ProSeries Express Refund 
Infoline.
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More about Refund Infoline

Refund Infoline allows you to provide your clients a toll-free telephone number that they 
can use to check the status of their tax return refunds and bank products at anytime. 
Using this feature eliminates the need to take calls from clients who call and ask “Where’s 
my check?” regarding the status of their income tax refund. When your clients call this 
number, they’ll have the option to hear the status of their tax refund in English or 
Spanish.

When your clients call the Refund Infoline, they’ll hear the most up-to-date status about 
their tax return, such as:

● Your refund is awaiting approval by the bank

● Your refund check is ready to be picked up

● Your cash card or direct deposit is funded

● Your tax return is pending approval by the IRS

After you’ve printed a client’s refund check and you’re ready for the client to pick up his 
or her return, you’ll use the ProSeries Express program to send a “Client Package Ready” 
message to the Refund Infoline system to change the status of the client’s refund. The 
Refund Infoline is automatically updated with client status by Intuit’s electronic filing 
system with one exception: your clients will not hear the “Your Client Package/Check is 
ready” message until you tell the Refund Infoline that you are ready for the client to 
know this status.

The Refund Infoline is a $199 value. However, you will not be charged for Refund Infoline 
for Tax Year 2005.

Setting up Refund Infoline

You can sign up for the Refund Infoline in one of two ways: (1) you can opt-in during the 
Options Setup Wizard, or (2) go to the Tools menu, select Options, then select Refund 

Infoline. In the Refund Infoline dialog box, select the Enable your clients to receive e-file 

and bank product status from the ProSeries Express Refund Infoline check box.

You can have ProSeries Express update the “Client Package Ready” status automatically 
when you print your client’s refund check. To do so, select the Automatically set the 

options to update the Refund Infoline status to “Client Package Ready” when checks are 

printed check box.

9. Print the client’s check for a 
Refund Anticipation Loan or 
Refund Transfer. (This step 
isn’t applicable for Refund 
Transfer Direct Deposits.)

a. If “Ready to Print” opens in the Status column of the Bank 
Product Clients view, select the client.

b. Go to toolbar then click the Print Checks button.

c. Deliver the check to the client.

10. If there’s a problem with a 
check, resolve the problem.

a. Go to the Bank Product Clients view and select the client 
whose check is affected.

b. Go to the E-File/Bank Products menu, point to Bank 
Products, then select Resolve Check Problems...

11. View or print Bank Products 
reports.

a. Go to the Bank Product Clients view and select the client 
returns that you want to include in the report.

b. Go to the E-File/Bank Products menu, point to Bank 
Products, then select Reports.

To take this step Do this
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Tip: You can also select (or clear) this option when you click the Print Check button on 
the toolbar.

Refund Infoline telephone number

When you meet with your clients to prepare their returns, you’ll give them the toll-free
1-866-373-9777 telephone number that they can call 24 hours-a-day, seven-days-a-week 
to get the status of their returns.

Using Refund Infoline

When you e-file a client’s tax return and then later want to update the 
status of his or her tax refund to “Client Package Ready,” click the Update 

Refund Infoline button on the ProSeries Express Edition toolbar.

You’ll probably want to update the Refund Infoline after you’ve printed refund checks for 
clients if you didn’t already select the check box to update the Refund Infoline 
automatically in the Options dialog box.

In the Update Refund Infoline dialog box, select the check box in the “Client Package 
Ready” column for the clients that you want to update. You can select individual or 
multiple clients to update. When you are ready, click Update. The program then 
transmits the “Client Package Ready” status to the Refund Infoline system.
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To view and confirm the client status, click the Bank Product Clients tab to see the 
“InfoLine Updated” column that shows the date that the updated status was sent to the 
Refund Infoline system.

For more information about Refund Infoline or bank products in general, use the Search 
Help feature on the Help pane, or select User’s Guide in the Help Center.

Troubleshooting suggestions

If this situation occurs Do this

A dialog box informs you 
that the computer doesn’t 
have enough disk space

1. Go to the Start menu, select Programs, then Accessories, then 
System Tools, and then click Disk Cleanup.

2. Try to install the ProSeries Express Edition software again.

3. If there still isn’t enough disk space, remove unused programs 
or data from the hard drive.

A dialog box informs you 
there was an error

1. Write down the error message, then restart the computer.

2. Go to the Start menu, select Programs, then Accessories, then 
System Tools, and then click ScanDisk.

3. After ScanDisk is complete, go to the Start menu, select 
Programs, then Accessories, then System Tools, and then 
click Disk Defragmenter.

4. After Disk Defragmenter finishes, run your virus-protection 
software.

5. Try to set up the computer again.

6. If you aren’t receiving the error message at other computers, 
continue setting up those other computers.

The ProSeries Express Edition 
program doesn’t start when it 
should

1. Restart the computer.

2. Make sure no other applications are running.

3. Double-click the ProSeries Express Edition 2005 icon on the 
desktop.

You still are unable to install 
or start the ProSeries Express 
Edition program

Start your Internet browser, then go to http://www.proseries.com 
to search for additional troubleshooting solutions.

You are unable to resolve the 
problem

Call ProSeries Express Edition Technical Support at 1-800-434-
6818. To save time, gather as much information as possible, and 
have your network administrator available.

Select this 
check box to 
update the 
Refund Infoline 
to “Client 
Package 
Ready” status.


